
 

Autodesk® Revit® Now Has Explode!...Well, Not Quite 
Paul F. Aubin   

AB2942 Got your attention, didn't I? Well thankfully, not that kind of explode, but rather 
"exploded" axonometric views. Using the new Displace Elements feature in Autodesk Revit-based 
software, we can create custom 3D views that "pull apart" our model to show how it fits together. This 
powerful tool is a great way to visualize any part of your Revit project. This feature can enhance nearly 
any kind of communication—from details and presentation views to marketing brochures and even 
product design documents. The best part is, the displaced view feature is view specific! This means 
that your exploded 3D view is a unique view of the model that does not affect any other view. However, 
as you would expect, changes to the main model do affect the exploded view as well. In this class, we 
walk through the process to create a displaced 3D view. We create the view, enable displacement, 
learn to move the pieces, and even add path lines to show where they came from. The potential that 
this tool opens up is vast, so come and have a look at this exciting new feature in Revit 2014! 

Learning Objectives 
At the end of this class, you will be able to: 

• Create custom and cutaway 3D views 

• Explain how to enable the displace feature to "pull apart" your model 

• Describe the view-specific nature of the displace feature 

• Create a full "exploded" 3D view to convey design intent 
 

 

About the Speaker 
Paul F. Aubin is the author of many CAD and BIM book titles including the widely acclaimed: The Aubin 
Academy Mastering Series: Revit Architecture and MEP titles. Paul’s newest title: Renaissance Revit: 
Creating Classical Architecture with Modern Software debuts here at AU. Paul is also the author of Revit 
video training for lynda.com www.lynda.com/paulaubin. He is an independent architectural consultant who 
travels internationally providing Revit® Architecture and AutoCAD® Architecture implementation, training, 
and support services. Paul’s involvement in the architectural profession spans over 20 years, with 
experience that includes design, production, CAD management, mentoring, coaching and training. He is 
an active member of the Autodesk user community, and has been a top-rated speaker at Autodesk 
University for many years. Paul has also spoken at the Revit Technology Conference (RTC) in both the 
US and Australia and other regional events such as the Central States Revit Workshop and CAD 
Americas. His diverse experience in architectural firms, as a CAD manager, and as an educator gives his 
writing and his classroom instruction a fresh and credible focus. Paul is an associate member of the 
American Institute of Architects. He lives in Chicago with his wife and three children. 

Contact Paul via the Contact link at www.paulaubin.com 

Follow Paul on Twitter: @paulfaubin  

http://www.lynda.com/paulaubin
http://www.paulaubin.com/
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Create Cutaway 3D Views 
The idea behind the Displace Elements feature is simple and straight-forward. It is useful to 
create “exploded” cutaway three-dimensional views. You can create a custom 3D view, and 
then using this feature, pull the model elements apart to represent how they will fit together. 
Using the tool is easy. The next several topics will look at various aspects of the feature.  

The Basics 
There are a few basics you want to be aware of. The first is that this is a view-specific tool. This 
means that like text, dimensions and tags, edits you make to displaced elements, only appear in 
the displaced view. Next, most model elements can be displaced. This includes system and 
non-system families. Finally, it is possible to displace sub-components of elements; both system 
and non-system families, we will look at strategies for how to do this below.  

Differences between various objects 
There are some noticeable nuances between the various elements. If the object is a system 
family it will behave a little differently than if it is a component family for example. Some 
elements are hosted to or part of other elements, so this will have an impact on how they 
behave. The best thing you can do is open a simple model and do some experiments. In the 
model I will work with here, I have a very small pavilion building. It has a few site elements like 
topo, a pad and a tree. There are exterior elements like a patio and low height wall and an 
exterior stair with railings. The small building contains walls, doors, windows, roofs, floors, 
ceilings, curtain walls, guardrails, fascia, gutters, roof windows and light fixtures. There is 
enough variety in this model to give us plenty to work with. So let’s take a look.  

 

We’ll talk about the various strategies in the topics that follow. This illustration shows a little of 
everything we will discuss.  
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Understanding the Displace Feature 
In this topic we will look at the mechanics of the displace feature. The steps are very easy:  

1. Create a 3D view 
2. Select one or more elements 
3. Click the Displace Elements icon. Move the displaced elements. 
4. Add paths and other annotation.  

Let’s explore each part of the process next.  

Create a Displacement View 
A displacement view is simply a 3D view. It can be an axonometric or perspective view. You 
cannot displace elements in a 2D view. If you need an exploded plan or elevation view, you can 
create a 3D view that is oriented to the desired direction. Creating 3D views is a basic Revit 
procedure, but let’s look quickly at the process involved.  

Axonometric—This is the simplest 3D view to create. Simply click the Default 3D View icon on 
the Quick Access Toolbar. If you have a default 3D view already (named {3D} or {3D – User 
name} on the project browser), Revit will simply open it. If you don’t it will create one with this 
name. You can rename the default 3D view to anything you like. Next time you click the icon, it 
will create a new one with the default name again. That’s just what it does…  

  

Perspective—To create a perspective view, add a camera. The Camera tool is on the drop-
down next to the default 3D view icon. You can start in any view, but it is often easiest to get 
good results by starting from a floor plan. Choose the camera tool and then click two points. The 
first point is where you want to have your viewer stand. The second point is the direction and 
location where you want to look. It is a good idea to place this second point beyond any model 
geometry. If you click too close to the first point, it will crop out the back of the view. This is the 
camera’s far clip offset.  
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Once you have a camera, the easiest way to adjust it is to use the steering wheel on the 
Navigation Bar. The steering wheel allows you to pan, zoom, twist, dolly and several other 
adjustments. It is very interactive and there is a Rewind option if you need to backtrack.  

 

Plan, Section and Elevation 3D Views—You cannot perform certain actions in 2D views. 
Among them is rendering and the displace function. If you wish to create a plan rendering, or a 
displaced elevation view, then you have to create a 3D axonometric view that is oriented to the 
desired 2D vantage points. This is easy to do with the Orient to View command.  
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Start by creating a default {3D} view. I like to rename it next. Naming views descriptively is a 
good habit to get into. So you might create a new copy of your 3D view and rename it to “First 
Floor Axon – Plan orientation” for example. Next, in this new 3D view, you will have the 
ViewCube visible in the corner. (If it is not showing, you can turn it on from the View tab, 
Windows panel and User Interface drop-down). Right-click directly on the ViewCube, choose 
Orient to View > Floor Plans > Level 1.  

 

Notice that you can do this for any other view, so be sure to experiment and/or create additional copies. 
If you orbit the view a little, you will see that this command has not only oriented the view to look straight 
down into the model like a plan, but it has also cropped the 3D view to match the view range of the floor 
plan. If you choose a section or elevation, it will match the extents of that view instead.  
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If you orbit the view into 3D, you will see a box surrounding the model with grips on each side. 
This is the section box. You can use the grips to modify the view and change how it is cropping 
the model. The shape of this box cannot be irregular. In other words, it has to stay a box, but it 
can be long and thin, tall, square, etc. You can even rotate it with respect to the model. We’ll 
consider this 3D copping a bit more later on.  

 

Displacement Sets 
A Displacement Set is simply a set of elements that have been displaced. A displacement set can 
contain one or more model elements. This includes linked files and imported CAD files! All 
elements in the set will be moved together when you adjust the position of the X, Y, Z control 
gizmo. You can also displace elements numerically with the dimensions on the Properties palette.  

 

When a displacement set is selected, you can edit it or reset it.  

Edit—Use Edit to add and remove elements from the set. This is useful if you did not select 
everything you wanted when first creating the set. The interface is similar to editing a group. A 
small floating tool panel will appear containing an Add and Remove button. Simply click the 
appropriate button and then select the elements you wish to add or remove. When you are 
finished, click the Finish button on the same panel. You can also cancel if you change your mind.  

6 
 



AB2942 Autodesk® Revit® Now Has Explode!...Well, Not Quite 

 

If you add an element to an existing set that you have already displaced (with the gizmo or 
numerically on the Properties palette), the newly added elements will immediately displace to 
match the rest of the set. Likewise, if you remove an element, it will return to its original position.  

Reset—If you want to remove the displacement set and return all of its elements back to their 
original positions, click the Reset button.  

 

Hosted elements 
Hosted elements will typically displace with their hosts. So if you add a wall to a displacement 
set, when you displace it, all of the hosted inserts in the wall will also displace. The same is true 
for ceilings and their hosted elements. This does not seem to be completely universal however. 
For example, displacing a stair does not automatically displace its railings. So a little trial and 
error is in order.  
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Nested Sets 
Given the behavior noted in the previous topic, you may be wondering if you can displace a 
displacement. It turns out that you can! So in the example noted above, if you displace a wall 
and then wish to displace the inserts separately, you would simply repeat the displacement 
process for the inserts. So step one would be to select and then displace the wall. Go ahead 
and move it with the gizmo to your desired location. Next, use your TAB key to highlight and 
select the inserts that you wish to displace. TABBING lets you highlight them even though they 
are inside another displacement set. You can then displace the selected hosted elements. The 
second displacement set will be “nested” inside the first. So later if you move the first set, it will 
move everything, including the elements in the second displacement set. If you select one of the 
elements in the subset, it will only move that set.  

 

Shared Families 
You can displace most component families. If you build your family from nested sub-component 
families, you can displace those as well, provided you set them to “shared.” A shared family is a 
family whose definition is shared between the project and the family in which it is nested. Such 
families will appear in the Project Browser’s Families branch on their own. You will be able to 
select the nested family individually (using the TAB key) and the nested family can be counted 
separately from its host and appear on schedules. A very common example is a table and 
chairs family. There is a basic example provided with the software in the Furniture/Tables folder. 
It is called: Table-Dining Round w Chairs.rfa. If you don’t have access to this file, you can find it 
on Autodesk Seek. (On the Insert tab in Revit, click in the Seek search field and type: “Table 
and Chairs.” When Seek loads in your web browser, click the Revit Architecture filter on the left 
side beneath Product Libraries; the file should appear).  
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If you select the family, the entire thing selects including the table and all of the chairs. But if you 
TAB, you can highlight and select one of the chairs. A furniture schedule will also list each chair 
separately. With the nested component selected, you can displace it! With this in mind, you can 
use this feature to create an exploded diagram of any complex model element you might create 
in the family editor. The only trick is you have to set the sub-components to Shared1.  

 

1 This model is from my new book: Renaissance Revit: Creating Classical Architecture with Modern Software. The 
model in the book does not use shared families, so to make this illustration, I had to modify the nested families to 
enable shared before using displace.  
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Using Parts with Displacement 
Using shared families as noted in the previous topic will help you if you want to displace sub-
components of an overall family. But this is not an option for all families. In particular, this 
approach is not available for system families (walls, floors, roofs, etc). In those cases, you can 
use parts. So for example, if you want to displace the layers of wall, you can first generate parts 
from the wall and then displace the individual parts in a way that is similar to that described for 
families with nested shared sub-component families.  

 

Parts is a feature that allows you to sub-divide an element into its constitute components. With 
the parts feature, you can take elements that have drawn to represent overall geometry and 
begin to model them more accurately. It is intended for those in the construction industry to take 
an architectural model and use it to represent actual construction and sequencing. For example, 
consider a concrete floor slab. In a typical architectural model, this slab would be drawn as a 
single continuous element. But when constructed, it would be poured in smaller sections. Using 
parts, you can take the single slab element and subdivide it into smaller parts. Parts have many 
features which are out of the scope of this paper, but the essential benefit that they give us 
when using the displace feature is that they provide a convenient way to break up families like 
walls, floors, roofs and slabs. Once we have the element divided into parts, we can displace them.  
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View-Specific Nature of Displace 
As noted above, Displace is a view-specific feature. So it applies only to the current view. This 
means that it will behave like other view specific features in Revit: 

• Changes to the displaced view apply just to that view.  
• Displacing elements does not move the actual elements, only their representations in the 

displaced view.  
• If you duplicate the view, the new duplicate will not be displaced. If you want a copy of 

the displacement, use Duplicate with Detailing. 
• If you want to annotate your displaced view, be sure to lock the view orientation first. 

You can then add view specific annotations and notes.  
• The displace feature includes its own “Path” feature which you can use to show where a 

displaced element’s original location is.  

The most important benefit to this view specific nature is that you can easily create a new 3D 
view, experiment with displacing elements and then if you don’t like how it came out, you can 
just delete the view. No permanent changes have occurred at the model level! This means you 
can make lots of experimental displaced views before you settle on the one you want to keep.  

Paths 
The Paths tool is available when a displaced element is selected. You simply click this button on 
the ribbon and then click on the displaced element to add a path. Continue clicking points to add 
additional paths. Displacement paths are view-specific like the rest of the displacement feature. 
However, the lines do appear in 3D space. So in a way, they are like special “view-specific 
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model lines.” They default to a dashed line, but you can customize this in Object Styles and 
Visibility/Graphics on the Annotation Objects tab. The name of the element is: Displacement 
Path. You can also select individual lines and customize their graphics individually as 
appropriate. You can use the Override by Element tool on the ribbon or right-click for this.  

 

There are a couple ways to customize the paths on the Properties palette. You can make them 
straight or jogged.  

 

When you have nested displacement sets (see above), you can also control the depth to which 
the paths will apply. Select a path element and then on the Properties palette, choose the 
desired depth.  
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Create an Exploded 3D View complete with annotation and paths 
Let’s look at a quick hands-on example. I am going to use a file called Pavilion-Displace, but 
you can use any file you like. Remember that the basic steps were outlined above: start in a 3D 
view, select one or more elements, create a displacement set, displace them, add any 
annotation including paths to finish the view.  

1. On the Quick Access Toolbar, click the Default 3D View (small birdhouse) to create a 
new view.  

 

If you already have a {3D} view, it will open. You can use this view, or rename your original and 
then click the Default 3D View icon again to create a fresh one. You can also use any other 
acceptable Revit method to create a 3D view. Any 3D view can use the displace feature.  

2. Select one or more elements onscreen. The elements you select will become a 
displacement set.  

3. On the Modify tab, click the Displace Elements icon. 
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4. Using the control gizmo onscreen or the X, Y and Z Displacement fields on the 
Properties palette, move the displace elements away from the main model.  

5. With the displacement set still selected, click the Path button on the Modify ribbon.  
6. Click points on the displaced elements to add paths back to their original locations.  

If you want to add annotation to the view, be sure to lock it first. 

7. On the View Control Bar, click the Locked 3D View icon and from the pop-up menu that 
appears, choose: Save Orientation and Lock View.  

 

8. You will be prompted to name the view.  
9. Add any annotation you wish. 

 

Additional Resources 
The displace feature can be driven by the Revit API (Application Programming Interface). The 
API is used to build custom apps and plugins for Revit. Harry over at Boost Your BIM has built 
two tools that take advantage of the displace feature. The free Level Displacer will take a building 
model and pull it apart level by level to make an exploded axon of the whole building. This tool is 
free and is much quicker than doing the same task manually. You can learn more here: 
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http://boostyourbim.wordpress.com/products/#LevelDisplacer 
Boost Your BIM also has the Image O Matic plugin. This tool has both a free and a paid 
version. It will take any family and flex it through several iterations and take a screen capture 
after each flex. These images can be composited into an animation if you have software that 
supports this. The tool also supports displace! So you can animate the exploded view. Very 
cool. You can learn more here: 

http://boostyourbim.wordpress.com/products/#Image-O-Matic  
 

Further Study 
You can find more information and tutorials in  
The Aubin Academy Master Series: Revit Architecture. (Displace is discussed 
briefly in the online PDF update for this book. The update PDF is free to 
download).  

If you want a deep dive into the Family Editor try my new book:  
Renaissance Revit: Creating Classical Architecture with Modern 
Software.  

Past Autodesk University Class: 

 

I also have Revit video training available at: lynda.com/AU2013/PaulFAubin. 
I have several Revit courses at lynda.com: Revit Essentials (2011 and 

2013), Revit Family Editor, Revit Architecture Rendering and 
Advanced Modeling in Revit Architecture, Phasing and Design 

Options, Up and Running and more on the way soon.  

The Revit Family Editor course is devoted entirely to the Family Editor and 
content creation. The Advanced Modeling course covers the Massing 
Environment as well as many other related topics.  

(I will be recording a course that covers the displace feature in the next few months. 
Keep on the lookout for it). 

 

 

If you have any questions about this session or Revit in general, you can use the contact form at 
www.paulaubin.com to send me an email.  

Follow me on twitter: @paulfaubin 
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